
Getting started with SmartCAM

Thanks for trialing SmartCAM Milling.

This tutorial can be used with Production Milling, Advanced Milling and FreeForm Machining.

If you would prefer to complete this online, you can find this tutorial here.
A CAM system is not something that you can simply click‐around in and achieve meaningful results. By their very nature they 
have technical content which needs to be explained.
So we created this work book to help you achieve some practical toolpath results during your early use of SmartCAM.
It is not intended to be a substitute for formal training but we hope it will help you begin to understand how you will do things in 
SmartCAM.

Help is available if you need it. If there is anything you do not understand as you work through this material, do not hesitate to 
ask us to provide assistance.

We have presented tasks and actions that you are asked to apply using red text and we have shown terminology associated with 
SmartCAM and SmartCAM usage in blue text. Examples are Layer, Step, Level.

SmartCAM Milling family applications progressively add functionality. All of the functions and tasks you will apply are 
available in all SmartCAM Milling applications. If you are trialing a higher-level application then this work book is a relevant base 
to begin your SmartCAM experience.

The Advanced Milling professional level application adds support for positional 4‐5 axis rotary axes, toolpath modeling directly 
on solid / surface CAD models, High‐Speed / Adaptive toolpath and a level of 3D‐3 axis toolpath modeling for localized features.

Everything that you can achieve using Production Milling and Advanced Milling is available in our premier milling system, 
FreeForm Machining, which adds 3‐axis toolpath modeling on complex solid and surface models.

Here we go, then...

The first thing to do is to download a Zip file containing the SmartCAM file for which you will model toolpaths. 
Click here to download that from our website.
Save the two files that are in the zip file to a folder of your choice on your PC.
You will be working on the following during this tutorial:

• Job Setup
• Machining closed and open regions
• Profileing
• Hole Operation

Let's start by opening the needed file.
Open any SmartCAM Milling product by double‐clicking the icon on your desktop or left‐clicking the program in 
the SmartCAM program group in your Windows Start button. For this tutorial, we are using Production Milling.

Left‐click the File > Open icon on the top toolbar, browse to the folder in which you have saved the downloaded 
file, and open "Getting Started with SmartCAM Production Milling - Metric.pm5".

Drag and Drop to Open: Let's also introduce you to a further method of opening files in SmartCAM...
You are able to open a file in a SmartCAM application by holding down a left-click on the file, dragging it 
from wherever it resides and dropping it (position your cursor over either a SmartCAM application icon or into 
the graphics area of an open SmartCAM application) and releasing the left mouse button.
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You will see a SmartCAM application screen layout similar to but not necessarily exactly the same as the one below.

Next you will create your very first SmartCAM Job.
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Task 1 - Job Setup

Target Machine/Code Generator

The target machine for which you want to create CNC code can easily be changed 
in a SmartCAM program. You are able to code for different machines and 
controllers that have identical configurations.

You can easily, for example, code the same job for a 3 axis mill control that uses a 
G-code structure and for a different controller that requires a conversational offline 
programming style.
Let's make sure an appropriate machine is selected for this exercise:

Left-Click on the Job Information icon near to the top-left of the SmartCAM 
window.
A Job Information panel is displayed.
The panel fields could be populated with information about the job, special 
instructions etc.

That information can be accessed when generating code and can be included 
in things such as message blocks in the CNC code and content 
of setup documents.

Left-Click on the Machine tab.

Note the SMG/SCT Pair has been preselected to use "3 Axis Milling Example". To change the SMF/CGT, simply click 

the File Select button.
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Tool Change /Home Position

Select the Work Setup tab and enable the Specify Home Position option.

Next we are going set the point for the home position tool change.

Left-click within the X: input field and type in 0.

Left-click within the Y: input field and type in 0.

Left-click within the Z: input field and type in 50.

Left-click the Tool Change drop down and select "Home Position".

This sets the tool change position equal to the home position for all tools. Left-click the Accept button. 

You now have set the Tool Change/Home Position for all tools.

When the home position is in use, Verify shows the first tool starting at home, tools returning to home for tool changes and 
then the last tool returning to home. For instructions on using verification, please see the Appendix.
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Task 2 - Rough the Pocket

SmartCAM should already be in CAM Mode.

If not, switch to CAM Mode by left-clicking the CAM radio button near the top-left.

First select the process STEP that you will use to generate toolpath once you have set 

this tool change position. The program should already be using Step 10, but if not:

Left-Click on the gray box at the right-side of the Step: value field.

A list of STEPS is displayed.

Step 10 includes a 12mm diameter End Mill that you will use for these first tasks. Left-

Click 10:Rgh Mill in the list.

Now set a Clear value in the Insert Property Bar appropriate for the machining processes.

Left-click within the Clear: input field on the Insert Property Bar and type in a value of 2.
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You are going to machine the pocket only at this time. We will then show you how you are able to modify the pocketing process to 
add avoidance of that island feature. We do it that way not out of necessity, but because it allows us introduce you to an important 
SmartCAM concept; modifying existing toolpath processes, (otherwise referred to as regenerable processes). You will be doing that 
in the task following this one.

Finish Allowance: It is a little tight in there for our chosen cutter diameter. Add just a 1mm Wall Allowance as a finishing amount.

Left-click in the Wall Allowance field and type in a value of 1.

Getting to Depth: If we are not to plunge to depth we must consider how we will get to depth for each Z level pass. We could have 
pre-drilled - you can see an option to specify a User Start Point were that the case - but here we will simply apply a Ramp feed move 
to each depth.

Left-click in the Ramp Angle field and type in a ramp angle value of 10 degrees.

Now select the boundary to pocket.

Left-click within the Boundary field or on the Boundary 

text to the left of the field. 

Left-click on any one of the elements that form the pocket 

boundary.

The cursor will have changed to a cross-hair cursor. Left-

click on the Go button.

A pocket roughing toolpath process is generated.
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Verification: Having created Toolpath, you can now use Verification to check the quality of your toolpath model. As a reminder, you 
can get details about Verification by looking at the appendix.

Notes:

View orientation and control is something that you will need to use a lot in any CAM system.

You can switch between Top view of the model by pressing the F9 and Isometric view by pressing F12 on your keyboard.

For additional details on switching views, see the Appendix. 

Toolpath: If you don’t like the Toolpath pattern that has been applied, there are more available in Path Type.

You can also make STEPS any color you like.

SmartCAM used default settings for the Width and Depth but you can over-ride those values as well.

The Final Pass Level was taken from the Z Level Property of the Profile Elements. Every SmartCAM element has properties 
associated with it which can be changed by you. Examples are Z Level, Profile Top, Clearance, Offset Side and CAD Layer or CAM 
Step.

It doesn't look significant in print, but those last two properties mean that you are easily able to change elements from CAD to CAM 
and from CAM to CAD: Drawing to Toolpath and Toolpath to Drawing.

Element Properties and the ability to easily change any properties for an individual element or a group of elements are an important 
SmartCAM concept and one that is unique to our system.

Pre-Drilling/Setting Depth: It would be so very easy in SmartCAM to now add a pre-
drilling task prior to the pocketing so that Z axis moves to depth at the start point that 
was automatically calculated by the pocketing routine can be programmed when using 
a non end-cutting tool.

We won’t get you to do that. We just wanted to let you know that it can easily be 
achieved in SmartCAM using our Insert Before / Insert After functionality.

Congratulations! – you have modeled your first toolpath and created your first CNC code using SmartCAM. If you want to save your 

toolpath model so that you can take a break and come back to it later:

• Left-click the ‘Immediate Save’ icon on the toolbar. This will save without a prompt.

The original file will be overwritten with your changes without any prompting.

• Or you can click File > Save or File > Save As from the main toolbar.

 For more information about Saving your SmartCAM files, see the Appendix.
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Task 3 - Add Island Avoidance

While you are able to carry out this next action by clicking on toolpath in the 

graphics view, we will use the opportunity to introduce another important user 

interface concept: the SmartCAM List View. 

Expand the content of the STEP by left-clicking on the + symbol that is to the left of 

the Step 10: entry at the bottom of the list view.

Right-click on the Pocket process within the step then left-click on the Container 

option.

(That’s the bit that you could also do in the graphics view: by right-clicking on any of 

the toolpath in the process.)

Left-click on the Recall command and you will have retrieved the pocket process, 

populated with the settings used when it was created.

Now select the entire pocket profile.

Set a profile group select mode by left-clicking the profile group select icon on the group select toolbar.

The icon will change to an active appearance.

Add the obround island profile to the Active Group by left-clicking any one of the elements that form it.
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Elements in the active group are displayed in an attractive shade of orange. You can change that color if you prefer something different. 

Avoidance of the elements in the active group by the pocketing process is an optional setting.

Let’s make sure that it is enabled.

Left-click on More… button in the Recall panel to open the Pocket Parameters.

Ensure that the Avoid Grouped Islands checkbox is checked. It can be toggled on and off 

by left-clicking the checkbox or the Avoid Grouped Islands text alongside it. 

Left-click Accept on the Pocket Parameters panel to close it.

Left-click the Regen button on the Pocket panel.

The toolpath will be modified to avoid the island feature.

Left-click Accept on the Pocket panel to commit the change you have made to the pocket process.

Notes: 
Some of the things you are able to do in the List View are:

• Move the insert position (the position at which the tasks you add are inserted, represented by ------------) by holding down a left-
click on it and dragging it or by right-clicking on the entry at which you wish to insert tasks either before or after.

• Re>-sequence content by dragging; that is holding down a left-click on the item you wish to move. You can, for example, 
rearrange toolpath elements and toolpath processes within STEPS or move entire STEPS. Additional resequencing functions are 
also available in SmartCAM.

The Active Group: We could take up a lot of your time telling you about the active group. Suffice it to say that a fundamental of 
SmartCAM is that you can establish an active group and then do something using it.
That something might be, for example, a toolpath modeling function, delete, move, rotate, copy, re>- sequence, flip from CAD to CAM 
or from CAM to CAD and so much more.

The Group Select Toolbar contains icons to set the selection mode: individual items, the profile select you have used, entire layers or 
steps, elements associated with a specific work plane and more. You remove items from the active group by holding down the Ctrl key 
while using a given selection tool.
A interesting technique is to save the active group as a named group so that the group can easily be recalled rather than needing to be 
reselected if later functions are to be applied to the same group of elements.
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Notes (cont')
Process Containers / Containers: SmartCAM containers can hold CAD layer elements, toolpath elements or toolpath processes. User 
containers can be created.

You used a regeneration method on an existing process container. In addition to being able to regenerate containers, most CAD and 
CAM elements in the SmartCAM model can be modified by right-clicking on them.

SmartCAM users are able to unpack container content, resulting in the expanded content being available in the List View. The reason 
that you may want to do that is so that you can, if necessary, modify any of the individual elements to precise needs.

We don’t propose that you experiment with any of those features at this point. We just wanted to make you aware of those key 
concepts.

Great!! You have learned how regenerable processes can be used to modify an existing toolpath process.

Verify the results and / or generate CNC code if you wish. As a reminder, you can get details about those in the Appendix.
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Task 4 - Rough the out open regions

One of the strenths of SmartCAM is that there are multiple methods of generating 
toolpath for those open pocket regions in SmartCAM.

You are going to use a method called Region Roughing. The region roughing process is highly flexible and is applicable to many 

applications scenarios. Stock- and Part-boundaries are defined, which can be fully closed or open profiles or a mix of both. Islands and 

voids (cavities not requiring machining) can be included.

You will be able to see the results more effectively in an isometric view.

Switch to an isometric view of the model using f12.

Let’s remove the existing toolpath from the display while you generate the region roughing toolpath. It will make it easier on the eye 

when carrying out the tasks.

Right-click on any element in the existing pocket roughing process toolpath.

Left-click on the Hide command on the menu that is displayed.

Region geometries are comprised of CAD Layer elements.

Create a new CAD layer on which you will create the regions.

Switch to CAD mode by left-clicking the CAD button at the top-left of the insert properties bar, or the 
CAD text alongside it.

Left-click on the down-arrow to the right of the Layer: field, and left-
click Add Layer on the drop-down menu.
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A floating Add/Edit Layer panel will display.

Left-click in the Name: field and type a meaningful name for the new layer. We 
named ours Regions. 

Left-click on your preferred color for the region geometry. We chose green.

Left-click on the Accept button to close the panel.

Now create the regions using stock and part profile inputs.

All geometry for those profiles needs to be at the same Z level for use in the 

region roughing process. We have already prepared a stock profile at an 

appropriate Z level.

Display our stock boundary by right-clicking on the Layer 6: RegionStock 
entry in the List View and left-clicking the Mask/Unmask command on the 
menu.

Mask/Unmask: You may have spotted that we had you use a Hide command from that right mouse button menu to hide the pocket 
toolpath in the graphics view, yet we asked you to Unmask a Layer in order to display our stock boundary.

Both commands can be  used to add or remove elements to the graphics view.

Additionally, Mask/Unmask controls processing of elements. Masked elements are inactive and are not processed by Verification or 
Code. You could use Mask to selectively view, verify or code a portion of the toolpath model.
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Now create the regions.

Left-click on the Create Regions icon near the top of the toolbar to the right of the graphics view. 

Left-click on the User Region command on the menu.

The User Region panel is displayed.

Both the Part Input and Stock Input fields should be set to Whole Profile. If not then left-click within the field and left-click on Whole 
Field in the list that is displayed.

The outer boundary profile of the component will be the part input to the command.

Left-click within the Profile / Start field in the left-hand, Part Input column.

Left-click on any element of the outer profile as indicated in the graphic below.

Take care to avoid areas where there are elements that are common to the stock and part profiles, and the possibility of selecting an 
element in an incorrect profile.

The stock boundary profile that you revealed using Mask/Unmask will be the stock input to the user region command.

Left-click within the Profile / Start field in the right-hand Stock Input column.

Left-click on any element of the stock profile, again taking care not to select an incorrect element. 

Check the Keep Original option checkbox.

Left-click the Go button on the panel and a set of four regions for the open pocket areas 
of the component will be created.

We won’t spend time taking you through how to view only those regions. An example is 
over there on the right.

The stock elements  of a region are displayed with a broken / chain line style, the part 
elements in a solid line style.
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Switch back to CAM Mode by left-clicking the CAM Radio button in the Insert Properties 
Bar near the top-left.

You will be adding region machining toolpath to the existing step that contains your 
pocketing toolpath.

SmartCAM should resume with STEP 10.

If not, then left-Click the gray box at the right-side of the Step: input field.

A list of STEPS is displayed.

Left-Click 10:Rgh Mill in the list.

Open the Region Rough Process panel by left-clicking on the Wireframe 
Milling icon on the top toolbar and left-clicking the Region Rough 
command on the list.

You will see a red-text "Group Required" conditional warning in the panel title.

The region rough process is applied to the active group; in this case comprised of the four regions that you just created.

Getting Started with SmartCAM Milling 14



Left-click the group select tool on the group select toolbar, and left-click the Layer7:Regions item in the list view.

The four region elements are added to the active group.

We are going to use a little bit of demo license here and machine those regions to size rather than include a wall finishing 
allowance. We will be getting you to finish profile the pocket and island. The techniques used to finish profile these four regions 
is identical.

Left-click the Go button on the panel and region roughing toolpath will be created for the four regions. 

You may wish to press f12 on the keyboard to centralize the updated toolpath in the ISO view.

Verify the results and / or generate CNC code if you wish. As a reminder, you can get details about these in the Appendix.
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Task  5 - Finish Profile the Pocket and Island

You no longer need those Regions to be in the active group.

Remove them from the active group by left-clicking the Remove All icon on the group select toolbar.

We suggest that you suppress the existing toolpaths from the graphics view in order to visually simplify the graphics while you add 
the finish profiling toolpaths.

You will be using a 10mm cutter to finish profile.

Select the STEP on which to generate the profiling process.

Left-Click on the gray box at the right-side of the Step: field. 

Left-Click 20:Fin Mill in the drop-down list.

Right-click on the Step 10: Rough Milling item in the List View. Or remember that 
alternatively you can right-click on any part of the toolpath in the graphics view.

Left-click on the Mask/Unmask command on the menu.

The toolpath is suppressed from the graphics view.
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Open the Profile Process panel by left-clicking on the Wireframe Milling icon on the toolbar and 
left-clicking the Profile command on the drop-down list.

The profile command can be used to create toolpath for whole or partial profiles using options selected from the Profile Input field 
drop-down menu.

Ensure that Profile Input is set to Group. If not then left-click within the Profile Input field and select Group from the drop-down list.

The Offset side on which to create the profile toolpath should be set to left. If not then left-click within the Offset Side input field and 
select Left from the drop-down list.

Let’s machine those profiles in a single depth pass.

Left-click in the Depth of Cut: field and type in a value of 30 (being deeper than the depth of the pocket).

You are going to profile the pocket and island by applying the command to an active group containing those profiles.

Add the pocket and island to the active group by left-clicking the Profile icon on the group select toolbar and left-clicking on an 
element in each of the pocket and island profiles.
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Now check some options for the command by left-clicking on the More… button.

On the Options tab of the panel that is displayed, note that the Profile command has its own clearance setting: It does not use the 
global setting that is displayed in the Insert Properties Bar.

Left-click on the Leads tab.

Here you can add a lead-in / lead-out style to the profile and you can control the 
application of cutter compensation codes.

Left-click within the Lead In Style field and left-click on the Line/Arc option from 
the drop-down list. 

A lead-in line and arc are calculated based upon the current tool diameter. Those 
values can be over-ridden if necessary.

Leave Lead Out Style as Match: The tool will approach and leave the profiles 
using line-arc moves.

Left-click Accept to close the parameters panel.

Left-click the Go button on the Profile panel.

Profile toolpaths with lead-in / out will be created for both profiles.

Left-click in the Clear Plane input field and type in the value 2. The cutter will retract 
to a safe height of Z2 between passes.
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Offset Side: Notice that the outer profile is in a counter-clockwise direction and the island is clockwise.

With that Left offset side setting, those profile directions and with a clockwise spindle rotation you have generated climb-milling 
toolpath for those profiles.

It follows that in the Profile command you are able to control climb or upcut milling with permutations of profile direction and offset 
side. For example, in order to upcut inside that pocket profile, it would be made a clockwise direction and an offset to the right applied.

Profile Start Point: The profile process uses the start point of the profile as a start point for machining. 

Profile directions and start points are easily modified using commands in the Order Path task set.

Verify the results and / or generate CNC code if you wish. 
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Task  6 - Program the Holes

For this next task, we’ll just hone in on the tasks you need to apply in order to load the 
steps for this hole machining from the KBM. 

Those holes are 10mm, representing an M10 tapped hole. Let’s spot drill them to 
11mm diameter, then drill and tap.

Tooling: There are multiple  ways of handling the cutting tools in a SmartCAM program:

• Define each tool / step you require ‘on the fly’
• Load individual tools / steps from a Knowledge Based Machining library, or KBM for short
• Load Groups of tools / steps from a KBM
• Load a set of tools / steps you have  used in an existing program
• Load a set of commonly-used tools / steps, where you have created planner content for each set Configure SmartCAM to load

a set of preferred / default tools / steps when starting  a new program

You’ll begin to understand that there is a great deal of flexibility when it comes to tooling, as there is in most things SmartCAM.

We don’t intend to detail all of those methods here. You will be loading additional steps for the hole making task from a KBM.

A sample KBM database is installed as part of SmartCAM. When you become a SmartCAM user you could either modify the 
content of our sample or begin a new one and populate it with the Tools and Steps specifically required for your CNC task.

There is much technical information for you to know about the KBM, but that is detail for another time.

Remove the pocket and island profiles from the active group by left-clicking on the Remove All Elements icon on the Group Select 
Toolbar.

Remove the Profiling toolpath from the graphics view by right-clicking on any part of it in 
the graphics view and left-clicking on Mask/Unmask.

Open the Job Operations Planner by left-clicking on the Operations Planner icon on the top 
toolbar.
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You will see the Process Step List, comprising of the steps we have applied so far.

Set the position at which to add new steps:

Left-click on the Step: 20 entry in the Process Step List.

Left-click on the Load Steps… button, which is toward the bottom-right of the Job Operation Planner panel.

The sample KBM is opened.

You could simply and easily add a single step from the KBM. We could have got you to do that three times for the tools we 
require, but we’ll go up one notch technically and will show you how to load the three hole tools you require in one go.

Fundamentally, you collect together the tools and / or steps you require from the KBM database; the area across the center of the 
panel showing the results of the various filters that you can apply.

You then drop your selection to the area across the lower part of the panel before adding them to the job planner.

It’s a little like that ‘add to basket’ that most of us do online.

First collect a 12mm spot drill.

Left-click in the Op Category field at the top of the panel.

Left-click on Hole Operations.

Spot Drilling is the top of the list in the Op Type field. 

If you like, experiment by Left-clicking in the Op Type field to take  a look at the hole operations. Be sure to ultimately select that 
Spot Drilling from the list.

Similarly, the Tool Category field should be displaying Hole Tools and the Tool Type should be Spot Drill.

The section at the center of the panel now contains all of the spot drills defined in our sample KBM.

Left-click on the 12.000 Dia drill, and then use the single down-arrow above the area across the bottom of the panel to add it to 
your collection.
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Now we’ll add an M10 tapping drill and tap.

Our sample KBM database has tapping drills and taps grouped together.

Disable Category/Type by left-clicking on the Category/Type checkbox at the top of the panel.

Left-click in the Groups field, over to the right a little. Left-click the Step Groups option from the drop-down list.

The area below now displays the sets of tool groups that are available the sample KBM database.

Scroll down the list using the vertical slider to the right of that list and left-click on our Feature – Hole Tapped 10.0 entry. 

The section at the center of the panel now displays the drill and the tap we grouped together for an M10 operation.

Left-click on the double down-arrow above the area at the bottom of the panel to add those 2 tools to your collection. 

Now left-click on the Accept button at the bottom-right of the panel to add your collection to the Operations Planner.

SmartCAM's flexibility very much applies when creating hole making toolpaths. There are a number of ways to program hole 
features. For now we are going to focus on one of the simplest - using a point at the hole center.

You will be creating the 3 points at the hole centres as CAD Layer geometry.

Switch to CAD mode by left-clicking the CAD button at the top-left of the insert 
properties bar or the CAD text alongside it.
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It is convenient to create the center points on the existing Layer 2. 

Left-Click on the gray box at the right-side of the Layer: field. 

Left-Click the 2:10mm Holes layer in the drop-down list.

You are going to snap to the center of each of those 3 holes.

Make sure that center point snapping is turned on. If not then left-click on it to enable it.

Now create the points.

Left-click on the Create Geometry icon at the top of the vertical toolbar over on the right, and 
left-click on the Point/Rapid command from the list.
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Left-click on the Point: field name. The text itself, not within an input field.

You will be creating the point elements using that coordinate mode we discussed earlier. Place your cursor over the center of one 

of the holes.

The cursor will change to a cross-hair when you are in the correct position.

Left-click in that position and an XYZ point will be created.

Repeat a center point snap at the centers of the other two holes.

Now generate hole making toolpath for those 3 point elements.

The active group should not currently contain any elements. If there are any then remove them from the active group by left-
clicking the Remove All icon on the group select toolbar.

Left-click the Add Elements group select tool from the group select toolbar.

Left-click on each of the 3 point elements you have just created.

The points are now in the active group.
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Left-click on the Hole Making icon on the top toolbar and left-click on the 
Point > Hole command from the list.

Populate the Point > Hole panel with step, hole depth and clearance height settings for each step to apply to the set of points in the 
active group: 

Left-click the gray box to the right of the field labelled 1st and left-click the 30: Spot Drl.

Left-click the gray box to the right of the field labelled 2nd and left-click the 40: Drill step.

Left-click the gray box to the right of the field labelled 3rd and left-click the 50: Tap step.

Spot Drilling: We said that we would spot drill to a diameter of 11mm.

Left-click within the Type field in the 1st row and left-click Spot Dia from the list.

Left-click within the Depth field on the 1st row and type the value 11.

Drilling: Those hole elements you created are at Z-20. The bottom of our stock is at Z-25.

Drill through by an extra 5mm at full diameter.

Left-click within the Type field in the 2nd row and left-click Full Depth from the list.

Left-click within the Depth field on the 2nd row and type the value 10 (being the difference between the hole and the bottom of 
stock, plus 5mm).

Tapping: Tap through by an extra 3mm.

Left-click within the Type field in the 3rd row and left-click Full Depth from the list.

Left-click within the Depth field on the 3rd row and type the value 8 (being the difference between the hole and the bottom of stock, 
plus 3mm). 

Left-click in the Clear: field and type a value of 3.

Left-click Go and the three sets of hole making toolpaths are created.

Note that there was, in this case, no need to switch to CAM mode to complete that last task. The Point > Hole command switched to 
each step in turn.

The process will have automatically reversed the direction of machining those holes for each of the three step passes. 
Verification:

You may want to unmask the other steps in the toolpath model that we have previously masked, because verifying the holes-only 
would show rapid collision moves in material that will be machined by the other steps & processes.

You can then verify your toolpath and generate CNC code. You could try that to experience a collision event.
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Left-click the Utility menu on the top toolbar.

Left-click the Mask/unmask… command on the drop-down menu.

The utility enables you to mask or unmask elements belonging to a specified 
step or all steps, Tools, Layers or Work Planes.

If the Steps radio button over on the left is not enabled then left-click on the 
Step radio button or the text alongside it.

If the Unmask radio button near the center of the panel is not enabled then 
left-click on the Unmask radio button or the text alongside it. 

Left-click on the All button.

Left-click on the Close button to close the panel.

All of the Toolpath you have created is added to the Graphics View.

Notes:
There are some aspects of programming holes in SmartCAM that we want you to make you aware of.

We used a method to program those holes that was simple to document.

But not quite the simplest to use. When in Step mode, you are able to define a hole at a point by simply using a Create Geometry > 
Hole or Group Hole command.

Technically-superior methods are Hole Feature-based. You are able  to create a hole feature at a point. Hole Features have attributes 
such as through / blind, taper angle, diameter and more. The hole making toolpath processes associated with hole features are that 
little bit more ‘expert’ and automatic than the method we have shown you.

It also occurs to us that if machining large numbers of holes in a component is a requirement in your application, that you’ll likely be 
thinking What?? I have to snap to the centre of each hole? A tubeplate, for example, might have hundreds, thousands of holes to 
machine.

Be assured that there are methods and techniques available in SmartCAM to make it easier and quicker to generate and optimize 
such hole making toolpaths. Just that here isn’t the place to cover it. Do speak with us if that is something that you specifically seek.

That completes the toolpath modeling we wanted to cover in this work book.

Well done! Thank you for the time you were able to spend learning SmartCAM Milling.

Left-clicking on View Filters… - near the bottom of the list - opens a panel that includes checkboxes to enable or suppress toolpath, 
wireframe or surface / solid
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A file browser will open in which you can change the path and filename for your saved copy of the toolpath model.

Enter a suitable filename and left-click the Save button.

If the target file already exists you will be prompted about over-writing it.

Appendix

Save your toolpath model at any stage so that  you can break off and come 
back to it later. You have a couple of options.

Save your changes in the original toolpath model file:

Left-click the ‘Immediate Save’ icon on the top toolbar.

The original file will be overwritten with your changes without any 
prompting.

Or if you prefer, save your changes to a new file: 

Left-click the ‘Save’ icon on the top toolbar.

Saving your SmartCAM Toolpath Model
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Alternatively, there are Save and Save As… commands in the File drop-down text menu at the top of the SmartCAM window.

Note: The File menu also includes a Most Recently Used (MRU) list, where recently used files can also be opened. You could use 
the MRU list to reopen your saved model when you resume these exercises after a break.

SmartCAM Verification

Verification is a dry run on the CNC machine. You can review toolpath with or without solid stock, can set automatic pauses at events 
such as tool change, every move, any collision and more.

Verification can warn of feed moves into fixturing, rapid moves into the remaining stock or fixturing, and collisions of the tool holder 
with the remaining stock or fixturing.

It’s not strictly necessary to do so, but if you have one open you are able to maximize space for graphics by closing the current panel. 

Left-click on the X at the top right of the panel.

You can Verify toolpath in any view of the model. We recommend that you use an Isometric view.

Switch to an Isometric view by pressing the f12 keyboard shortcut.

Left-click the Verify Toolpath icon on the top toolbar.
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The Verification panel is displayed. 
Note that it is floating (i.e. not located at any fixed position on the screen: you are able to hold down a left-click on the title bar at the 
top of the panel and drag it to wherever you prefer).

A stock boundary CAD Layer has been created for use when Verifying this example.

Display the stock by Left-clicking the Toggle Stock Visibility icon at the left hand end of the Verification panel.

You may wish to experiment with those speed setting + and - buttons during verification of your toolpath.

Left-click the Play Verification button near the center of the panel to Verify the toolpath.

When you are ready, exit Verification by left-clicking on the X at the top-right of the panel. 

Creating CNC Code

About the machine configuration. The software tools used in SmartCAM to configure and control CNC output code are referred to as 
Code Generators by the SmartCAM community. Those things that are referred to as Post Processors in other systems.

Code Generator technical information is a learning topic all of its own and we don’t intend to cover the detail here. Suffice to say that 
the SmartCAM CNC Code creation system is probably the most open in the CAM industry. SmartCAM users are able to modify a 
code generator to output CNC code exactly as they require it to be.

If needed, your SmartCAM provider can offer you a code generator writing service.

Left-click on the Create NC Code icon on the top toolbar.

The Code panel is displayed.

Filename Suffix: SmartCAM has defaulted to a name for the CNC code file of the same name as the current program, but clearly 
you are able to type any filename you like into the Code File: field.

The suffix / file type you will add to CNC code files that you generate is entirely your preference and can be set as an option. We 
have used a .txt file extension.

If a suffix is not present then left-click after the filename in the Code File: field and append .txt to the filename.

Enable Open Code File by left-clicking on the checkbox and the CNC code file will be opened in an editor when you generate it.

Left-click the Create Code button and your CNC code file will be created.
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View control in SmartCAM

SmartCAM is big on keyboard shortcuts. As your SmartCAM learning progresses you will discover that there are shortcuts for many 
SmartCAM actions and tasks. You can also add shortcuts of your own for your own unique purposes.

Here are some commone view shortcuts:

• f9 would switch to an XY Plane or Top view
• f10 to an XZ Plane or Front view
• f11 to a YZ Plane or Right view
• f12 for Isomentric view

Dynamic Viewing: When you press and hold down the Ctrl and Shift keyboard keys together you are able to dynamically rotate, 
pan and zoom the model view using your mouse / pointing device.

The wheel will have two functions, one when simply scrolling it, the other when used as a button when depressing the wheel.

The function of each of those keys can be re-assigned according to user-preference.

This information by no means details the complete scope of views and view controls in SmartCAM, but it should be helpful as you 
trial our CAM system.

Switch back to a Isometric view of the model by pressing the f12 keyboard shortcut.
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